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Quarter fold greeting card template word

By Craig Witt Developed by Microsoft and included in your Office suite of productivity software, Word allows you to create print-formatted documents such as letters, envelopes, brochures, and forms. Although you can manually configure the page and layout scaling elements associated with a greeting card document, both Word 2007 and Word 2010 provide
access to a number of formatted templates that can save a lot of time. As long as you have a network connection, accessing these templates and formatting a greeting card in Microsoft Word becomes quick tasks. Click the Office button near the upper-left corner of the Microsoft Word program window and select New. Look at the left column in the resulting
dialog box and select the Cards item if you use Word 2007. In Word 2010, double-click the Greeting Cards folder located near the middle of the screen. Click the specific category that corresponds to the type of card you want to create—for example, Friendship and Love Cards or Occasion Letters and Events. Double-click the name of the template you want
to use. Also click I agree if prompted by Word. The template file will be downloaded to your computer and will appear on the screen in a few seconds. Click a text box, select the reserved text, and then edit or replace the default template greeting as needed. Highlight the text you just edited and select the Home tab located near the top left corner of the
window. Specify your preferred formatting - font face, font size, colors, italics, underlining - by selecting the corresponding options in the Fonts section of the Home tab. If you want to use the default template formatting, skip this step. Click once on the default image, click the Delete key, and select the Insert tab located near the upper-left corner of the
window. Select the Image button located in the Illustrations section, locate your favorite cover image, and then insert it by double-clicking the icon. If you want to use the default model image, skip this step. Click the Office button again and select Save. Name the file, select a save location, and click the Save button to confirm your choices and save the
greetingcard document to your computer. After learning how to make welcome cards, you can express your sincere feelings with style. Friends and family are always moved by the thought and effort that a home card communicates. Making welcome cards is a great activity for parents and children to share. It's fun, creative and produces feelings that the
whole family will love. On the following pages, you will learn how to make welcome cards for each occasion. Have fun creating cards with all your A hug card for you This winning greeting card design will surely put a smile on someone's face – especially if it's accompanied by the real thing! View View Here. Learn how to make vibrant welcome cards or create
a collage to preserve birthday memories. Read about you're looking at the next page. Cookie Cutter Cards These creative cards come in all shapes and sizes. Learn how to make them for the holidays, or just for fun. Cross-Stitch-Look Christmas Card This traditional Christmas card will touch the heart of those who receive it. Find out how to make this card
sincere. Fuzzy greeting cards Have fun when you design your own fuzzy greeting cards. These three-dimensional greetings will thrill friends and family. See more here. Of course are nature cards Capture the beauty of nature with these delicate greeting cards. Learn how to create classic natural designs on this page. Paper pockets You can fill paper pockets
with almost anything. They are a welcome card which is also a gift! Get instructions on how to make paper pockets. S Stained Glass Heart Show that someone special you care about when you make a delicate S stained glass heart. Find out how to express your suit feelings. A hug card for you is perfect for anyone in your family who needs a hug. Learn how
to make this creative greeting card on the next page. Learn how to do everything you need to pack and send gifts. Read: Teach Your Kids How to Make Your Parent A Hug For You Card. Tell them to give him a double hug - one for real and one that he can carry with him all day. How to make a hug for you card what you will need: Ad construction
paperScissorsMarkersCraft glue 1. To make the card, cut a large head shape the size of a plate and draw on the hair and face so that it looks like you. Cut an 18x4-inch rectangle. These will be the arms. Glue your head to the middle of your arms. 2. Now crawl around your hands on a separate sheet of paper, and cut the shapes of your hands. Glue one
hand to the tip of each arm. Fold your arms so your hands overlap. 3. Inside your arms write a message to Dad, as here is a big loving hug for you on Father's Day! The only thing he could like more than this card is a real hug to go along with it! Card tailors are a great way to create beautiful images with only scissors and glue, especially for those who are
not skilled in drawing. Learn how to make Card Clippings on the next page. Learn how to do everything you need to pack and send gifts. Read: To make Card Clippings, it is best if you saved birthday or holiday cards. Use them to create a memory collage, new greeting cards or special decorations. How to make card clippings what you will need: Welcome
cards GlueCortrução Papermarkers Remember your birthday with a memory collage. Cut the cover designs and greetings inside old birthday cards. Paste them into a random pattern on a piece of construction paper. Write the date of your birthday in the collage.2. To make new greeting cards, fold a piece of paper in half. Cut pictures of old cards. Glue them
in front of the construction paper. Then write your own greeting inside. Ad 3. To make a Christmas decoration, cut different photos of various Christmas cards. For example, cut a photo of Santa Claus from a card, a picture of gifts from another card, and a tree from a third card. Then glue them together on a piece of paper to make a picture of Santa Claus
putting presents under the tree. Teach your kids how to make welcome cards with interesting shapes. Find out how to make Cookie Cutter Cards on the next page. Learn how to do everything you need to pack and send gifts. Read: When you and your kids make cookie cutter cards, they can use Mom's cookie cutters to create quick and easy note cards for
a friend. Silver dots add extra shine! How to make cookie cutter cards what you will need: CardstockBrightly Colored Colored Paper Cookie CutterSilver Glitter PaintPencilTracing PaperScissorsCardboardCraft GlueCraft Stick 1. Cut the cardstock to the desired size. Fold the sheet in half. Advertising 2. Place the cookie cutter on top of the colored paper and
trace around it. Cut the shape. 3. If you don't have cookie cutters, you can track or photocopy these patterns and make cardboard models. Track the models on colored paper and cut. 4. Using the craft stick, spread glue on the back of the cutout shape. Glue shape in front of the card. Let the glue dry. 5. With silver glitter paint, make small dots around the
shape contour. Allow the ink to dry completely. Cross-stitch-look Christmas cards look like needle patterns. Learn how to make these unique Christmas cards on the next page. Learn how to do everything you need to pack and send gifts. Read: When you submit the Cross-Stitch-Look Christmas Card, everyone on your list will be touched by the nostalgic
beauty and your breeding skills. How to make a christmas card cross-stitch-look what you'll need: 3-7/8 x 6 inches (42 x 65 square) White 11-count Aida ClothFine Line Fabric Markers: Gold, Red, Green4-3/4 x 7 inch Parchment Card and EnvelopeOne 5/8 inch Gold Jingle Bell 1. The characteristic look of the crossstitch is usually done with needle and floss
in fabric that has a weaving made to look square. Instead of using a needle and floss, you'll use fabric markers to make the X's, carefully drawing from a corner of the square diagonally to the opposite corner. Advertising Then make the other line by crossing the first, taking care to draw from corner to corner. Practice making X's on extra cloth aida before
starting this project. 2. Following this chart, and with the help An adult to start with, make X's on the aida cloth to create a golden bell. Count the rows of squares (over and over, etc.) on the chart and then on your cloth will help you find your starting point. You're going to to be extra careful not to smudge any paint. After the bell is complete, make the red arc
and the border green. 3. To mount the aida cloth on the parchment plate, apply a thin thread of glue along the edges of the back of the aida cloth. Position the cloth on the center front of the card. 4. Using the glue gun, place a small amount of glue on the clapper of the bell you drew on the cloth. Place the golden jingle bell from top to bottom on the glue.
Fuzzy Greeting Cards are a fun and creative way for your kids to express their feelings all year round. Find out how to make them on the next page. Learn how to do everything you need to pack and send gifts. Read: Give your family and friends Fuzzy Welcome Cards that you and your kids design together. Find creative ways to say Happy Birthday, Stay
Well Soon, Thank You or I Love You. Your friends and family will agree that a handmade card is the best type of card! How to make fuzzy greeting cards what you will need: Construction paperScissorsGlueChenille StemsPomsGlitterNuque plus what you would like! 1. Use your imagination and chenille stems to make welcome cards for every occasion! Fold,
fold, twist and wrap chenille rods in all kinds of fun shapes and drawings, and glue them to construction paper or stationery. Advertising 2. Be generous with your glue, and let it dry completely. 3. Be very creative beautify with poms, gems, dimensional ink, or anything else you can dream of. Of course, nature cards are collages that use the beauty of nature
to express suit feelings. Read about these delicate cards on the next page. Learn how to do everything you need to pack and send gifts. Read: Of course, Natural Cards are beautiful and easy to make. An icy layer of fabric gives these greeting cards the look of handmade paper. You will love sending them to friends on birthdays and holidays. Don't be
surprised if they save your card because of its beauty! Advertising Colorful construction paper Loaded flowers and white sheets facial fabricRulerScissorsTacky GlueToothpickSpoonSpoonPaintbrush1. Measure, cut and fold a piece of construction paper to make a blank card the size you want. 2. Arrange pressed flowers and leaves in front of your card to
make a beautiful design. Glue them in place with small drops of glue and a toothpick. 3. Mix a spoonful of glue with a spoonful of water in a bowl. Place your card on the work table and brush some of this watery glue on the paper around your flowers and pressed leaves. 4. Unfold a fabric and pull the 2 layers of the fabric. Place a layer on top of your card. 5.
Drip gently and brush au glue on the fabric so that it sinks on the flowers and leaves. Reserve the card to dry. 6. When the card is completely dry, use scissors to cut extra fabric from the edges. Fold the card again and write a message inside. Paper pockets are are cards that you can use to store things inside. Find out how you and your kids can make paper
pockets on the next page. Learn how to do everything you need to pack and send gifts. Read: Learn how to make Paper Pockets, the welcome card that is also a gift. If you want your Christmas or birthday cards to be really special, put a candy along with your messages inside a playful paper pocket. How to make paper pockets what you will need:
PencilPoster BoardBlunt ScissorsHole PunchRulerYarn or RibbonMarkersValentine Candy 1. Draw a heart shape on a piece of poster plate. Stop it and draw another heart on the poster. Cut the second piece. Advertising 2. Drill holes around the sides and at the bottom of the two cards, making sure the holes align with each other. The holes should be about
1/2 inch away. 3. Thread the threads or tape through the holes to sew the pieces. Tie a bow at each end. 4. Decorate the outside of the pocket with markers and fill it with valentine's candy. A Stained Glass Heart is a colorful and creative way to show someone you care about. Find out how to make one on the next page. Learn how to do everything you need
to pack and send gifts. Read: The Heart of Stained Glass is a delicate design that will show someone how much you care. The contrast between a black background and colorful fabric paper makes your design come out. How to make a stained glass heart what you will need: black construction paper Light colored pencils or chalk fabric
paperScissorsSacorado Cola 1. Fold a piece of black construction paper in half. Using a piece of chalk or a pencil of light, draw half a heart shape along the fold. Draw shapes inside the heart to cut. Advertising 2. Cut the shape of the heart as well as the inner shapes, then glue different colors of tissue paper on the back of the paper to cover the inner clipping
shapes. 3. Hang that stained glass paper heart on a window so that the light shines through it. You can also make stained glass paper snowflakes using this technique. Learn how to do everything you need to pack and send gifts. Read: Cross-stitch-look Christmas Cards by Cindy Groom Harry and StaffNaturally They're Nature Cards by Janelle Hayes and
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